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ARTICLE 

Document Comparison 

W 
hen editing documents using Notepad++, LibreOffice Writer, or Mi-

crosoft Word, it’s often useful to be able to compare the current and 

previous versions of the file in order to identify the changes that have 

been made. Fortunately, all of these editors have the appropriate functionality 

available to make the process quick and easy. In contrast, comparing two PDF 

files, at least in a GUI environment under Windows, generally requires the use 

of proprietary PDF editing software since this feature tends to be only in the 

premium versions of such packages. However, at least one free version of a well-

known PDF editor offers this capability on a trial basis. 

 

Notepad++ 

File comparison is not built into Notepad++, but the Compare plugin readily 

allows the content of two text files to be compared side-by-side. Installing the 

plugin is simply achieved by navigating to Plugins > Plugin Admin > Compare > 

Install. The plugin is used when two text files are open in separate tabs. By con-

vention, Notepad++ assumes that the old file is open in the first tab (the left 

pane in the display) and the current (or new) file is open in the second tab (the 

right pane in the display). The comparison of the contents of the two files is dis-

played by navigating to Plugins > Compare > Compare. 

Figure 1. Differences between two versions of a text file 

Figure 1 shows the backup copy of 

the list of Q&A topics, opened from a 

USB flash drive, in the left pane, and 

the current version of the file, opened 

from my main hard drive, in the right 

pane. Note the new lines of text, 

highlighted in green, in the right pane 

while lines that remain unchanged 

are displayed as normal text. 

 

LibreOffice Writer 

Comparing two open document text 

files (ODT) in LibreOffice Writer is 

undertaken by opening one of the 

files and then navigating to Edit > 

Track Changes > Compare Document. A 

pop-up dialogue box allows browsing 

to the file to which the open docu-

ment is to be compared. Once the 

selection has been made, Writer dis-

plays the merged text from both files, 

highlighting the additions and dele-
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Next Meeting 
 

Wednesday, January 14 

Technology Always Seems to be Changing the Way We 

Listen to Music 

Speaker: Ray Baxter, Payson Computer Meet-Up Club 

(APCUG) 

We’ve all experi-

enced the changes 

technology has 

provided over the 

last several decades 

in almost every 

facet of our lives. 

How we listen to 

our favourite tunes 

at home and in our 

cars has probably 

seen the most changes. In this presentation, Ray will 

review how we’ve listened to the music we choose in 

our homes, starting with the 78-rpm record and all the 

devices in between, bringing us up to date with to-

day’s various streaming options. Then, the focus will 

move to how we consume music on the road, starting 

with when it was so “cool” to have a push-button AM 

radio in the car. Moving to today’s options, Ray will 

discuss how to utilize your existing compact disc col-

lection now that new cars no longer have a CD player, 

streaming from an online service, using Bluetooth, 

flash drives, smartphones, and more. [More...] 

This meeting will be via Zoom video conference. 

Join us at https://tinyurl.com/opcug-meeting. The 

Zoom link will be live at 7:15 pm. The meeting will 

begin at 7:30 pm. 

Coming Up… 
 

07 Jan  (no Q&A on Dec 31) 
Weekly Q&A session 

08 Jan (Bonus presentation - see article next page) 
How to take better vacation pictures 
Speaker: Lynda Buske (OPCUG) 

11 Feb 
The Ins and Outs of Electronic Mail 
Speakers: Chris Taylor & Alan German (OPCUG) 

11 Mar 

NAS in the Home Environment 

Speaker: Bill Van Dijk (OPCUG) 

08 Apr 
Restoring old photos 
Speaker: Lynda Buske (OPCUG) 

13 May 
Ask the Geeks! 
Geeks: Alan German, Chris Taylor, Harvey Hope, Steve Parker, Tom 
Trottier (OPCUG) 

See all our scheduled events here. 

 

OPCUG Presentations at the OPL: 

Saturday, 17 Jan, 2:00 pm - 3:00 pm 
Armchair travel: Iceland (Lynda Buske) 
Nepean Centrepointe Branch 

Tuesday, 20 Jan, 2:00 pm - 4:00 pm 
How to make a hard copy photo book (Lynda Buske, Chris Taylor) 
Ruth E. Dickinson Branch 

Thursday, 22 Jan, 2:00 pm - 3:00 pm 
Armchair travel: the Danube (Lynda Buske) 
Centennial Branch 

 
See all our presentations with links to the OPL here. 

CALENDAR 

Event Date Time and Venue 

Next Monthly Meeting Wednesday, January 14th 
7:30 pm via Zoom video conference: https://tinyurl.com/opcug-meeting 
See all our scheduled monthly meetings here. 

Next Q&A Session Wednesday, January 7th 
Q&A sessions are held weekly except on monthly meeting nights.  
Join us most Wednesdays at 7:30 pm for weekly Q&A. 

Next OPL Presentation Saturday, January 17th See all our presentations with links to the OPL here. 

 

https://opcug.ca/events/music-and-its-ever-changing-delivery/?occurrence=2026-01-14
https://opcug.ca/events/music-and-its-ever-changing-delivery/?occurrence=2026-01-14
https://opcug.ca/events/music-and-its-ever-changing-delivery/?occurrence=2026-01-14
https://tinyurl.com/opcug-meeting
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/events/how-to-take-better-vacation-photos/?occurrence=2026-01-08
https://opcug.ca/events/the-ins-and-outs-of-electronic-mail/?occurrence=2026-02-11
https://opcug.ca/events/nas-in-the-home-environment/?occurrence=2026-03-11
https://opcug.ca/events/restoring-old-photos/?occurrence=2026-04-08
https://opcug.ca/events/ask-the-geeks/?occurrence=2026-05-13
https://opcug.ca/#upcoming
https://opcug.ca/mec-category/opl-presentations/
https://opcug.ca/mec-category/regular-monthly-meetings/
https://opcug.ca/events/qa-weekly-session/
https://opcug.ca/qa/
https://opcug.ca/mec-category/opl-presentations/
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CLUB LIFE 

Nominations for OPCUG Board for 2026 

Once a year, the OPCUG holds elections for the 9-member Board of Directors. We are once again coming up to this annual event. 

We encourage all members to consider running for a board position or getting involved in some other manner in 
the operations of the OPCUG.   

If you want more information about what is involved, please talk to me or any current or past Board member. 
Names are listed in the Newsletter and on the web site. 

Nominations can be submitted via email to Lynda Buske, Election Chair, at:  

nominations2026@opcug.ca. 

Nominations must be received by midnight, December 31, 2025. 

Please get involved.  Please help the OPCUG continue in its role of  Users Helping Users! 

 

Lynda Buske 

Election Chair 

 

Let’s grow the OPCUG 

Once again, the Board of Directors has decided to offer a “two for one” special to new members. Sign up for a $20 membership by 
March 31st, 2026 and get an additional year at no additional cost. Please spread the word and help the OPCUG grow. 

As well, the OPCUG finances remain in excellent shape and membership renewal dues are being waived. All members in good standing 

on March 31st, 2026 will have their membership expiry date extended by an additional year at no additional cost (if you do not know 

your membership expiry date, please contact the membership chair at membership@opcug.ca before sending payment). 

Membership Drive  (visit https://opcug.ca/join-or-renew/) 

Speaker: Lynda Buske, OPCUG 

Between weather and viruses, the winter months can be challenging for attending live lectures. Don’t worry, OPCUG is offering a Janu-

ary presentation on How to take better vacation photos that you can enjoy from the comfort of your home. Learn some techniques from 

Lynda Buske on how to tell captivating travel tales with no captions required! 

The zoom lecture will take place on Thursday, January 8 at 7pm EST and will last approximately one hour. 

Where: 

Hosted on Zoom at https://tinyurl.com/opcug-bonus01 

If the above easy-to-remember link doesn't work, you can use: 

https://us02web.zoom.us/j/85667952843?pwd=bIadkxFtnVt5KH1FQO4elXnGqGLepu.1 

Or join by entering the meeting ID in the Zoom app: 

 Meeting ID: 856 6795 2843 

 Passcode: opcug 

How to take better vacation photos (Bonus presentation) 

 

mailto:nominations2026@opcug.ca
mailto:membership@opcug.ca
https://opcug.ca/join-or-renew/
https://tinyurl.com/opcug-bonus01
https://us02web.zoom.us/j/85667952843?pwd=bIadkxFtnVt5KH1FQO4elXnGqGLepu.1
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Cell Phone Photography 

by Lynda Buske 

I t is impossible for me to write an arti-

cle about cell phone photography that 

would cover the advantages and disad-

vantages of every make and model. 

Even if I was capable, it would probably 

be out of date within a few weeks. To 

keep abreast of changes and features, my 

advice is to ask questions online and 

then watch recent YouTube videos spe-

cific to your make and model of phone. 

This article will cover some standard 

phone features and limitations as well as 

a couple of more recent techniques that 

may not be available on your model. 

The main advantage to cell phones has 

always been that they are small and usu-

ally with you, especially when you are 

travelling. I always tuck mine into my 

camera bag even if I am shooting pri-

marily with my Nikon Z6. I may use it 

to scout out different angles as it is easier 

to try out a shot with the phone than 

move my tripod around. There are some 

situations where I will shoot with both 

and decide later which one did a better 

job. The cell phone image may also give 

me an indication later of what edits I 

could do with my Nikon shots but per-

haps not to the same extent. When creat-

ing the JPEG, cell phones often sharpen, 

dehaze and add vibrancy and it is hard 

to undo what is baked in if I feel they 

have gone too far. For example, if I’m in 

a foggy environment, my cell phone as-

sumes I don’t want the mist and tends to 

apply a dehaze function. Wrong! Many 

phones now have extra enhancement 

editing features available after you have 

taken the shot but the original may still 

be pretty processed. 

A guide to digital photography for computer enthusiasts. After the click of your camera, you’re only half done! 

THROUGH THE LENS 

Often cell phones these days have the ability to adjust the brightness level when 

you are shooting. This is the equivalent to the EV adjust (+/-) button on your 

traditional camera. 

When shooting dark scenes without a tripod, a traditional camera will usually 

bump the ISO – the light sensitivity – to give you a fast enough shutter speed to 

hand hold your camera. This causes “noise” or graininess in your image which 

must then be removed with editing software. Most cell phone cameras have a 

wide aperture so you can get the most light and fastest speed possible indoors 

or in dimly lit areas. As well, in night mode, it takes multiple images, combin-

ing them together to keep sharpness and limit noise. I have even taken photos 

of constellations and northern lights! 

I have been pleased with some images that were taken with my cell phone dur-

ing blue hour (the hour before sunrise, the hour after sunset). With landscape 

photography, it is great having foreground to add a three-dimensional effect 

and allow the viewer to journey through the image. Before the sun comes up 

(or after it goes below the horizon) the sky is full of lovely pinks/oranges but is 

much brighter than the rest of the scene so if my Nikon exposes for the sky, I 

have to lighten the dark foreground areas after and sometimes (even with 

RAW files), it can look muddy. In extreme cases, you can get banding in dark 

areas. The best solution is to take two images, exposing for the sky in one and 

the foreground in the other. However, to do this you need a tripod and photo 

editing software that allows you to combine them later. Cell phones handle this 

high dynamic range (HDR) situation very well and in effect does take multiple 

images, metered to different areas of the scene and merges them together right 

on your phone. See Figure 1. 

Some phones allow for a simulated adjustment of aperture but it is not a true 

optical adjustment as you would have on a camera. The wide aperture can 

sometimes work against you when taking close up photos. With mine, the 

depth of field is so small that I cannot take a photo of my meal in a restaurant 

without leaning far back in my chair or standing up! 

(Continued on next page) 

Figure 1: Blue hour 
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When set to portrait mode, the cell 

phone creates a blurred background 

similar (sort of) to a short depth of 

field with a traditional camera. On 

my phone, sometimes it’s a nice soft 

blur (see Figure 2) and sometimes it’s 

a rather chunky AI creation that I 

don’t find appealing. If I’m taking a 

photo of a person where there is a 

cluttered background in behind, even 

if I’m not in portrait mode, it will ask 

if I’d like the background blurred or 

people removed. I don’t get these 

prompts if it is an inanimate object 

like a vase of flowers (I have not yet 

tried it with animals). See Figure 3. 

Photography  (Continued from previous page) 

It can also create the softening effect on 

moving water. There is probably a long 

exposure setting on your phone camera 

that will take multiple shots and then com-

bine them, causing the water to blur nicely 

but keeping everything else in sharp focus. 

The zoom advertised with cell phones can 

be misleading. It may claim to have a 30x 

zoom but that is not the equivalent in 

quality to a 30x zoom in a standard cam-

era. 

 Optical Zoom uses the camera's lens to 

physically magnify the image, main-

taining sharpness and detail. 

 Digital Zoom simply enlarges a portion 

of the image sensor's output using soft-

ware, which often results in lower im-

age quality by cropping and magnify-

ing pixels. 

Phones typically combine several fixed 

focal length lenses for up to about 3x opti-

cal zoom but beyond that it relies heavily 

on digital zoom and computational en-

hancement, which results in softer, more 

pixelated images.This can result in a very 

unnatural capture of your subject. 

Some of the more recent phone features 

may tempt to you to upgrade your device. 

In some later models, you can take a pho-

to of your travel companion, have them 

take yours and the phone will combine the 

two together so it looks like a third person 

Figure 3: Removing people from background 

Figure 2: Portrait mode 

had taken the shot for you. As well, 

some of the newer phones will com-

bine and create the best image 

among multiple people shots. For 

instance, if you take three photos of 

a large group or people, it will select 

the best image of each person (no 

closed eyes, not looking away) and 

create a final image. 

With some newer phones, you can 

ask it how to create a better image. 

It will look at your scene and make 

suggestions based on well-

established composition guidelines 

like leading lines and rule of thirds. 

These suggestions could help you 

become a better photographer!  

 

Additional information from Chris 

Taylor: 

Phones will sometimes brag about super-

high resolution such as 48 megapixels or 

even 108 megapixels. But you may be 

disappointed when you find the resulting 

images are just 12 megapixels. Although 

the sensor may actually have 48 or 108 

megapixels, the phone is doing 

"pixel binning" to combine grids of 4 or 9 

pixels into a single output reading.  

While it sounds like they are lying—in 

reality they are being disingenuous. Pixel 

binning is done to increase the light-

gathering capability. The result is that the 

camera can take pictures in lower light at 

the cost of fine details in resolution. Pixel 

binning also reduces the effect of optical 

crosstalk, where photons of light intended 

for one photosite are detected by adjacent 

photosites, reducing image sharpness and 

causing color inaccuracies or blurring at 

the pixel level. 

 

 
Here is another article by Lynda Buske on 
Cell Phone photography from 2021. 

Read all of Lynda’s articles here. See her presentations at the Ottawa Public Library (select Lynda Buske as Organizer). 

Figure 4: Long exposure 

https://opcug.ca/Photography/CellPhonePhotography.pdf
https://opcug.ca/digital-photography/
https://opcug.ca/mec-category/opl-presentations/
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tions, and allowing the changes to be accepted or rejected. 

(Figure 2) 
 

Figure 2. File comparison in LibreOffice Writer 

 

 

Microsoft Word 

In Microsoft Word the comparison is called from the menu 

by navigating to Review > Compare > Compare. A pop-up dia-

logue box requires both files that are to be compared to be 

selected. The resulting display (Figure 3) is rather complex. 

 

In this case, the change to the document is that a text box 

has been added with the included text highlighted in yellow. 

Note that this is displayed on three separate parts of the 

page. The revised text is shown in the left column, while the 

content of the current version of the document is displayed 

in the middle column (the normal window for viewing the 

Word file). The column on the right perhaps provides the 

best view of the actual changes. The old version of the docu-

ment is displayed at the top of the column, and the new ver-

sion is displayed at the bottom of the same column. 

Figure 3. Document comparison in Microsoft Word 

Comparison  (Continued from page 1) 

PDF-Xchange Editor 

For several years I have been using PDF-XChange Viewer 

as my default PDF file viewer; however, the developer has 

effectively replaced this program with PDF-Xchange Edi-

tor. The new program functions just fine as a PDF viewer 

but includes a number of features that allow modification of 

PDF files, such as text editing, annotation, OCR, and file 

merging operations. A PDF file comparison tool is also 

included in the free version of PDF-XChange Editor; how-

ever, its use is restricted to a trial basis such that, if any pre-

mium feature is invoked, watermarks are added to the re-

sulting file. Notwithstanding this limitation, the file com-

parison is useful for viewing changes. 

 

For example, Figure 4 shows the comparison of the last 

page of the final article in my Trading up to Linux series. 

This series was originally written for OPCUG’s newsletter 

but was subsequently reprinted in Full Circle Magazine, a 

Linux-based publication distributed online from the UK. 

The final article in the series appeared in the September, 

2025 issue of Ottawa PC News, just ahead of the deadline for 

Windows 10 End of Life (EOL). In contrast the Full Circle 

Magazine version was reprinted in the October issue when 

Windows 10 EOL had already occurred. In consequence, it 

was necessary to change the last paragraph of the original 

text to reflect this timing. 

 

The changes are readily seen in the PDF-Xchange Editor 

screenshot as the relevant sections of the text are highlight-

ed. Note also the yellow banner above the text indicating 

that “...DEMO stamps will be placed on all pages if the 

document is saved.” 
 

Figure 4. PDF file comparison using PDF-Xchange Editor 

 
 

 

 

(back to Table of Contents) 
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W indows provides many customizations for how icons of running programs are displayed on the taskbar. To access 

the settings, press Windows+i to run Settings and navigate to Personalization > Taskbar > Taskbar behaviours. 

 

Taskbar alignment: the default is Centre. In a nod to users who understand that Windows was always meant to have the Start 

button and program icons left-aligned on the taskbar, you can choose Left. 

 

  
                             

                          Left-aligned taskbar 

Automatically hide the taskbar: the taskbar is hidden so you have a little more screen real estate. Move the mouse to the bot-

tom of the screen to have the taskbar slide back into view. This setting can also be useful for those with OLED screens, 

which can burn in if you have a constant image displayed. 

Show badges on taskbar apps: allows programs to add overlays such as number of unread messages for an email program or 

the Windows Clock app has an active alarm set. 

 

 

             The green dot badge on the Windows Clock app indicates an active alarm 

Show flashing on taskbar apps: When a program requires attention, the icon will flash. For example, this occurs when a User 

Account Control prompt is triggered for a program that is buried under other windows. 

Show my taskbar on all displays: for multi-monitor configurations. 

Share any Window from my taskbar: Hover over a taskbar icon while on a videoconference to get a Share this window prompt. 

As of this writing, it only works in Microsoft Teams. 

Select the far corner of the taskbar to show the desktop: moving the mouse to the bottom-right will show a tool-tip Show desktop 

and clicking the mouse minimizes all windows, displaying your desktop. Clicking it again before doing any other operation 

returns the windows to their original state. 

Combine taskbar buttons and hide labels: Always is the default—names of running programs are hidden and if programs have 

multiple instances running, their taskbar icons are combined into a single icon on the taskbar. Hover over an icon to see 

and select any instance. Never prevents any combining of multiple instances and always displays the names of running pro-

grams. When taskbar is full acts similarly to Never except that as the taskbar fills, icons get smaller and multiple instances of 

programs start reverting to a single icon. At some point, some running programs are hidden from view and can be accessed 

by clicking the 3 dots that appear just to the left of the system tray on the right. 

 

 

 

 

 

(Continued on next page) 

ARTICLE 

Taskbar behaviours by Chris Taylor 

Three instances of PDFgear in “Always” combine mode with mouse hovering over PDFgear icon 
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         Three instances of PDFgear in "Never" combine mode 

 

Show smaller taskbar buttons: the default—When taskbar is full—will shrink taskbar icons as the taskbar fills, allowing you to 

see more icons. Always forces small icons even if you have oodles of space. Never prevents them from shrinking even if the 

taskbar fills. In all cases, at some point, as you run more program simultaneously, some running apps will be moved to the 

hidden area which is accessed by clicking the 3 dots that appear just to the left of the system tray on the right. 

     

    Show smaller taskbar icons 

 

 

Taskbar behaviours   (Continued from previous page) 

 

Quick Tip 80: Downdetector 

by Chris Taylor 

 

I 
t can be really annoying when you try 

to access a website and nada. You 

wonder if it is your computer that is 

the problem. You try other sites and they 

work. It is even more problematic when 

the website seems to be working, but a 

specific service—such as sign-on—isn’t. Is 

it a problem with your account or the site? 

Downdetector can help identify if the 

problem with the remote site. It provides 

real-time status on user-reported outages 

and disruptions for thousands of online 

services. It includes charts showing report-

ed outages in the past 24 hours, maps and 

lists of cities with the location of users 

reporting problems, comments from users 

and more. 

 

https://downdetector.ca/ 

 

 
 

 

Heat map showing user-submitted problems in past 24 hours 

https://downdetector.ca/
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The Birth of Quantum Viability? 

By: David Kretchmar, Hardware Technician 
Sun City Summerlin Computer Club 
https://www.scscc.club  
dkretch (at) gmail.com 

 

I 
 discussed the potential and problems relating to a new 

type of computer, the quantum computer In the October 

2024 Gigabyte Gazette Kretchmar’s Korner, https://

www.scscc.club/Gigabyte/gg_2024-10Oct.pdf. Most data 

scientists agree the quantum computer has the potential to 

revolutionize many aspects of our world; quantum compu-

ting has the promise of being the most important technologi-

cal advancement of the 21st century. But that will take many 

years, possibly even a decade or longer, or our world might 

end before quantum computing becomes a reality. 

 

Most of us do not have the education or intelligence to even 

begin to understand how quantum computers function, but 

neither do any but a handful of our fellow humans. What we 

can do is to “Follow the Money” and see the money flows 

into entities that have the potential to ride the wave of the 

coming quantum revolution. What can this tell us about the 

brave new world of quantum computing? 

 

Google shakes up the world 

On December 9, 2024, Googles Hartmut Neven, Founder 

and Lead, Google Quantum AI, announced a breakthrough 

in quantum computing by their latest quantum chip, Willow. 

Willow performed a standard benchmark computation in 

under five minutes that would have been impossible for to-

day’s fastest supercomputers. Neven stated that, “Willow 

moves us significantly along that path towards commercially 

APCUG 
relevant applications”. Google has been developing the 

Willow chip over the past 10 years – this was no overnight 

success. 

 

While Neven’s claim has been met with a mix of excite-

ment and skepticism in the scientific community, it under-

scores the revolutionary potential of quantum computing 

technology. Over the next two days Google stock jumped 

by $20, over 10%, to an all-time high. 

 

Google is a $2.3 billion* dollar corporation earning profits 

of 100 billion dollars a year. There is no way even a signifi-

cant advancement in quantum computing is going to add 

anything to Google’s bottom line, probably for at least the 

next decade. Quantum computing is currently nothing but 

a cash drain on Google and anyone else involved in quan-

tum research, yet the market rewarded Google’s announce-

ment. Investors are not required to act rationally, but when 

we see that kind of activity in one of the most significant 

companies on earth, there must be something going on. 

 

IBM is a leading player in the development of quantum 

computers, and this seems to play into IBM’s concept of 

huge, centralized computers. Yet IBM’s stock price has 

fallen a few percentage points since Google’s announce-

ment. This indicates that investors either think IBM is on 

the wrong track, or maybe just that IBM, even with decent 

technology, lacks the capacity to be a successful quantum 

player. 

 

Pure quantum plays 

Some much purer and more speculative quantum stock 

plays took even bigger jumps than Google. IonQ, Inc. rose 

over 300% in December 2024. Rigetti Computing, Inc. was 

happily bumping along at less than $1 per share as late as 

October 2024. As 

I write this article 

the money flow 

into Rigetti main-

ly during Decem-

ber 2024 has 

pushed the share 

price to over $16. 

Rigetti trading 

volume has in-

creased from a few million shares a day to over 200 million 

shares per day – out of the 280 million shares it has out-

standing! Each of these quantum computing companies 

had their own positive announcements concerning corpo-

rate quantum activities and progress. 

 

* The author meant that Google is a 2.3 trillion-dollar corporation 

(at time of writing).      —OPCUG editor                    

(Continued on next page) 

https://www.scscc.club
https://www.scscc.club/Gigabyte/gg_2024-10Oct.pdf
https://www.scscc.club/Gigabyte/gg_2024-10Oct.pdf


 Page 1 0 

 Volume 43,  Number  1  

The universe of pure quantum stocks is tiny. Obviously just 

a bit of news can result in dramatic price swings. I mention 

IonQ and Rigetti specifically because these seem to be the 

quantum stocks followed most closely by analysts. I was 

unable to identify a mutual fund or ETF that could serve as 

a proxy for pure quantum plays. Defiance Quantum ETF 

(QTUM) is a well-known fund that sounds like it would be a 

good candidate, but no more than 15% of its assets are in 

pure quantum plays. Its two biggest holdings are IonQ and 

Rigetti. 

 

Public interest in quantum computers 

CBS’s 60 Minutes television show featured a piece on the 

state of quantum computing that was rebroadcast on De-

cember 24, 2024. The original episode aired on July 28, 

2024, and that episode was an update of a December 2023 

piece. This was an unusually technical topic for mainstream 

TV audiences, but it introduced many quantum concepts 

and was interesting even for non geeky viewers. In that seg-

ment 60 Minutes visited Google’s quantum lab in California 

and explored one of the first quantum computers working in 

the real world at Cleveland Clinic. Stories such as this have 

helped stimulate the general public’s interest in quantum 

computers and possibly precipitated some of the cash that is 

now being poured into quantum stocks. 

 

Artificial Intelligence (AI) and quantum computers 

The value that real world quantum supercomputers will pro-

vide the world will only be realized by leveraging the power 

of AI to bridge the gap between quantum and conventional 

computers. The power of AI can be increased exponentially 

when AI is combined with the power of quantum. This is 

becoming clear to those working in quantum computing, 

and that realization is forcing greater corroboration between 

AI and quantum experts. 

 

For the past 70 years AI has been around mostly as a con-

cept. Only in the past several years has AI started to live up 

to its hype and promise and now is appearing increasingly in 

our world. 

 

The manifestation of AI in the real world was preceded and 

accompanied by massive flows of money into AI companies 

and corporate entities (the Magnificent Seven) that have 

Quantum   (Continued from previous page) 

data gathering capabilities. This has enabled them to accu-

mulate vast amounts of data, the new gold. Nvidia, the big-

gest beneficiary of the world’s adoption of AI technology, is 

often mentioned as a company with the potential to connect 

quantum computing and AI. 

 

 

Conclusions 

Could the flow of money into quantum stocks be an indica-

tion that the world is on the verge of an even more sophisti-

cated - and possibly more life-changing technology that will 

have its century in the sun? 

 

Huge entities like Google have the capacity to support inter-

nal quantum development, but others will feel the need to 

acquire this capacity by buying smaller pure quantum plays. 

This might have contributed to the runup in the stock price 

of many of the pure quantum companies. 

 

Will the success of companies like those comprising the 

“Magnificent 7” be echoed in the stocks in corporations 

with significant quantum computing exposure. The world’s 

most successful corporations, like the “Magnificent 7”, will 

require quantum computing technology to remain magnifi-

cent. We might be witnessing the birth of the quantum rev-

olution at the end of 2024. 

 

Or is the nascent bubble in quantum stocks a tiny blip in the 

long-term story of the market? Could the runup in these 

stocks be telling us that quantum is the next bubble, succes-

sor to investors frenzied buying of AI stocks or cryptocur-

rencies? Is quantum computing the “Next Big Thing? 

 

I believe the quantum revolution is for real, but we can ex-

pect bursts of optimism and deluges of disappointment over 

the next few years. 

 
 

 
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Q&A IS ON-LINE! 
Weekly! 

 

Since the pandemic, the OPCUG has 

been holding weekly Q&A sessions 

in Zoom video-conferences. 

Join us every Wednesday (except on 

regular monthly meeting nights) at 

7:30 pm to discuss computer issues. 

Questions (and answers) on any com-

puter-related issue are welcome.  Or, 

do you have a favourite computer 

program or topic that you would like 

to share with the group?  Send your 

questions, answers, or the details of 

what you would like to share to:  

SuggestionBox@opcug.ca 

Everyone is welcome to attend Q&A 

sessions and to ask questions about 

their specific computer-related prob-

lems.  Join us at: https://

tinyurl.com/opcug-meeting (if you 

use the Zoom client, the meeting ID 

is 924 9556 0898 and the password is 

opcug). 
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